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ELECTRONIC SPREADSHEETS 
 

Introduction: 

 

Refers to software used to manipulate numbers and figures and also perform advanced chart 

drawing. Spreadsheets can do a lot more than simply adding up a column of numbers. 

Spreadsheets can handle financial calculations for a large business, calculate profitability or 

other statistical information, do complex trigonometry and make colourful graphs and charts.  

 

A spreadsheet is a grid of rows (horizontal lines) and columns (vertical lines). 

 

TYPES OF SPREADSHEETS 

 

There are two types of spreadsheets: 

1. Manual Spreadsheets 

2. Electronic Spreadsheets 

 

MANUAL SPREADSHEETS 

 

A manual spreadsheet is a spreadsheet that consists of a book with many sheets divided into 

rows and columns on which data elements are entered manually using a pen/pencil. 

  

Examples of Manual spreadsheets  

 

1. Ledger book 

2. Counter book 

3. Manuscript 

4. Accounts Analysis book 

 

ELECTRONIC SPREADSHEETS 

  

Is a computerized spreadsheet that enables users to enter data in rows and columns and 

manipulate data automatically using in-built formulas and functions. 

 

Electronic spreadsheet is application software which enables users to organize and analyse 

numeric data presented in a grid of rows and columns. 

 

 With electronic spreadsheets, one does not need a paper, a pen, ruler and a calculator 

because the screen is already divided into rows and columns into which data can be entered 

using a keyboard and manipulated using in-built formulas and functions. 

 

EXAMPLES OF ELECTRONIC SPREADSHEET SOFTWARE 

 

1. Microsoft Excel 

2. VisiCalc (Visual Calculator) developed in 1978 

3. Lotus 1 -2-3 developed in 1983 

4. Corel Quattro pro 
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5. Super Calc 

6. Symphony 

7. Lotus freelance 

8. Multi Plan 

9. View Sheet 

10. Wiki Calc 

 

COMPONENTS OF SPREADSHEETS 

 

1. Worksheet 
Is a single sheet in a workbook made up of rows and columns where data entry and 

calculations can be carried out. 

 

2. Graph/Chart 
Pictorial representation of data on the worksheet .e.g. Column, Bar, Pie, Line etc. 

 

3. Database 
Is a data management feature of a spreadsheet software is found on the data menu (Excel 

2003 or Data Tab (Excel 2007/2010). Data entered in the spreadsheet can be manipulated 

by sorting, filtering and sub-totaling. 

   

ADVANTAGES OF USING ELECTRONIC SPREADSHEETS OVER MANUAL  

 

1. Have large sheets compared to manual spreadsheets. 

2. Automatically adjust results whenever the value in a that is referenced in the formula. 

This feature is called Automatic recalculation. 

3. Have better editing and formatting features hence produce neat work. 

4. Easy entry of data due to typing aids such as auto complete, Auto correct, Auto fill, copy 

etc. 

5. It allows easy management of large amounts of data using data management features such 

as sorting, filtering, and Sub-totaling. 

6. Analytical graphs/charts lets one provide visual presentation of data from a worksheet. 

 

APPLICATION/USES OF SPREADSHEETS 

1. Compiling and Analysing Statistics 

2. Mathematical and Scientific Calculations 

3. Inventory management:  

4. Accounting 

5. Performing calculation. 

6. Creation of charts/graphs. 

7. Forecasting/management.( Performing What if analysis) 

8. Sorting/arrangement of data 

9. Home and personal use 
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FEATURES/CHARACTERISTICS OF MICROSOFT EXCEL 2010 

1. Excel 2010 files are called Workbooks. Each workbook may contain worksheets, chart 

sheets and Visual programming modules. The numbers of worksheets you can create and 

store is limited only by the memory within your computer. 

2. New Templates and Wizards that make creating personal and business worksheets very 

fast such as Balance sheet, Expense statement, Loan Amortization, Sales Invoice and 

Timecards. 

3. What if analysis. The term what-if analysis refers to the ability to change in the 

spreadsheet and immediately see the effect it has on other calculations. E.g. what if my 

salary is only 200,000/=?. How would that affect my net income? 

4. Automatic recalculation (a feature in spreadsheet that automatically adjusts results when 

a value in a cell is changed that is referenced in the formula. 

5. Built-in formulas and functions. A formula is a sequence of values, cell references and 

operators in a cell that together produce a new value. A function is a predefined formula 

used to perform a calculation.  

6. Data validation 

7. Sub-totaling/summarizing data. 

8. Wizards which simplify the process of creating of entering functions, analyzing data, 

importing text and working with databases. 

9. Excel 2010 provides productivity enhancement tools such as Auto Calculate, 

AutoComplete, AutoCorrect, AutoFilter and Auto format features. 

10. Excel 2010 has an improved file search utility.  

11. Data Map Utility lets you create geographical maps and pinpoint demographic 

information such as age, income, and education statistics and analyze trends using 

numerical worksheet information. 

12. Dialog boxes which enhance opening, saving and managing your worksheet documents. 

13. Excel 2010 Ribbon enables easy access to formatting, drawing, charting and other 

commands. 

14. Cells (Intersection of a row and column) 

15. Rows and columns 

16. Range (a group or block of cells that can be selected and manipulated as a block/group ) 

17. Worksheets. 

18. Work books (a group of worksheets in a single file) 

19. Ability to create charts. 

20. Sorting/ arrangement of data 

21. Filtering data. 

22. Macros  

23. Goal seek 

 

MICROSOFT EXCEL 2010 

 
Excel is an electronic spread sheet program/software used to manipulate numeric data, 

perform calculations and also perform advanced chart drawing. 

 

An electronic spread sheet is a computerized equivalent of a mammal spread sheet e.g. a 

Ledger book, counter book etc. 
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STARTING EXCEL 

1. Click the start button 

2. Point to programs 

3. Click Microsoft Excel 

Or 

You can also double click the Ms - Excel short cut on the desk top to launch Excel. 

THE MICROSOFT EXCEL 2010 SCREEN 

                          A 

B 

C 

D 

 

E 

 

F 

G 

                       

 

 

 

 

   Sheet Tab  Status Bar   Horizontal  Vertical 

         Scroll Bar Scroll Bar 

A - Title Bar 

B – Control Menu  

C – Tabs (File Tabs, Home Tabs, Insert Tab, Page Layout etc) 

D – Ribbon 

E – Name Box 

F – Formula Bar 

G – Active Cell/Current cell.  

Cell Pointer 
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TITLE BAR 

This is the top most bar across the Ms Excel screen containing the name of a program (Ms- 

Excel) and the name of the workbook (i.e. Book1,if you have NOT yet saved your workbook) 

RIBBON 

The ribbon makes it easy for you to find commands and features that are frequently used. 

The Ribbon, which is part of the Microsoft Office Fluent user interface, is designed to help 

you quickly find the commands that you need to complete a task. Commands are organized in 

logical groups that are collected together under tabs. Each tab relates to a type of activity, 

such as writing or laying out a page. 

FORMULAR BAR 

The formula bar normally appears bellows the formatting toolbar or above the worksheet. 

This is where data and formulae appear as you type in the active cell. 

The cell contents may also be edited in the formula bar. 

STATUS BAR 

It is located at the bottom of the Ms – Excel screen. At its left side is a brief description of the 

currently selected command or active command while the right side shows the keyboard 

mode/indicators such as Num Lock, ADD, EXT etc. 

WORKSHEET 

A worksheet is the primary document used in a spreadsheet program. It is made up of rows 

and columns. 

The worksheet is used to store, Manipulate, Calculate and analyses data such as numbers, 

Text and Formulae. 

In Excel 2010, Each worksheet is made up of 512 Columns labeled A-Z, AA – AZ, BB – BZ 

up to XFD  and Rows labeled 1 – 1,048,576. 

ACTIVE WORKSHEET  

Is sheet that you are currently `working on in a workbook. The name on the sheet Tab of the 

active sheet is bold. 

CELL 

The intersection of a row and column is called a Cell. A cell is a basic unit of a worksheet in 

which data is entered, stored and manipulated. 
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ACTIVE CELL 

Is the selected cell on the on the worksheet in which data is entered when you begin typing. 

Only one cell is active at a time. 

The active is bounded by a heavy border known as a cell pointer.  

The rectangular highlight that marks the currently cell on the worksheet is called the cell 

pointer. 

HOME CELL 

Is the first cell of the worksheet (intersection of column A and row 1) 

When you start Excel, the cell pointer is always positioned in cell A1, this is known as the 

home cell. 

Whenever you want to make an entry, the cell pointer must be positioned in only one cell, 

this is called the active cell or current cell. As type the data, it appears both in the active cell 

as well as in the formula bar. 

CELL REFERENCE 

Cells in a worksheet are defined by a column letter and row number e.g. A1 refers to a cell in 

column A and row 1, this is known as the Cell Address or Cell reference or cell co-ordinates. 

A cell reference is a set of coordinates that a cell occupies on the worksheet. E.g. B2, J27, K2 

Therefore a cell address is the location of a cell on the worksheet 

WORKBOOKS 

A workbook is a file that contains one or more worksheets that you can use to organize 

various kinds of related information. 

Or 

A workbook is a collection of worksheets. 

Files in a spreadsheet are called workbooks. Microsoft Office Excel 2010 displays Book 1 at 

the top of the Excel screen if you have not yet saved your workbook. 

By default, Microsoft Office Excel 2010 opens with three worksheets within a single 

workbook. However, more worksheets can be added later. The sheets can be worksheets or 

Chart sheets. 

 

 

Moving/Navigating around the Worksheet using a Keyboard 

 

1.    - Moves up one cell 

2.   - Moves down one cell 
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3.   - Moves right one cell 

4.    - Moves left one cell 

5.  Ctrl +  - Moves to the last column. 

6.  Ctrl +  - Moves to the first column. 

7.  Ctrl +  - Moves to the first Row (Top of the worksheet) 

8.  Ctrl +  - Moves to the last Row (Bottom of the worksheet) 

9.  Home   - Start of the current Row. 

10. Ctrl + Home  - Beginning of the worksheet (cell A1) 

11. Ctrl + End - End of the Worksheet data. 

12. Page Up - Moves up one screen (previous page)  

14. Page Down - Moves down one screen (Next page) 

15. Alt + Page up - Moves one screen Left. 

16. Alt + Page down - Moves one screen Right. 

17. Ctrl + Page up  - Moves to the previous worksheet. 

18. Ctrl + Page down - Moves to next worksheet. 

19. Ctrl + G or F5  - Addresses a named cell. 

 

ENTERING DATA 

In Microsoft Excel, data is entered in the current/active cell. 

To enter data: 

1. Click the cell into which you want to enter data to make it active. You can also use 

the arrow keys to the cell. 

2. Type the required data e.g. numbers, symbols e.t.c. 

 (as you type, the data appears in the  formula bar and in the active cell) 

 To erase unwanted characters, press backspace. 

3. Press enter or click the enter box in the worksheet. 

 To cancel the entry press Esc or click the cancel box x on the formula bar. 

 To move to the next cell, press the tab key or an arrow key. 
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EDITING DATA ON THE WORKSHEET 

If you notice a mistake after you have finished entering data, do the following:  

1. Double click the cell containing the data you want correct the cursor appears.   

2. Use of backspace /delete key to remove the unwanted characters. 

3.  When done, press, enter.  

 OR 

1. Move the cell pointer to the cell contain the data you want to edit. 

2. Press F2, the cursor appears. 

3. Correct the mistakes as required. 

4. When done, press enter. 

DELETING DATA 

1. Click the cell containing the data you want to erase. 

2. Press the delete key. 

TYPES OF DATA ENTRIES 

Microsoft Excel recognizes the following types of data: 

 

1. Label/Text entry 

2. Number/Value entry 

3. General 

4. Currency 

5. Date. 

6. Time 

7. Percentage 

8. Fraction 

9. Scientific  

10. Accounting 

11. Special 

12. Custom 

VALUE 

Is a number entry e.g. the result of a formula you view in a cell. 

It refers to data that can be evaluated numerically including numbers, dates and mathematical 

formulas. 

A value can either be data you type directly into a cell or the result of formula in the cell. 
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CHARACTERISTICS OF VALUE ENTRIES: 

1. Always right aligned on entry to the worksheet. 

2. cannot split into adjacent cells, instead if the entry is to much to fit into the column, it 

turns into a row of hashes (####) indicating that the column is not wide enough 

3. Can turn into a label/text entry if you start the entry with a single quotation 

mark/apostrophe. For examples years must be entered as labels. 

 

LABEL /TEXT ENTRIES 

Is a text entry e.g. a column heading. Labels are text or a combination of text and numbers 

you enter into a cell. 

A label is an entry consisting of text such as Report titles, column and row headings. Labels 

can consist of any combination of letters, numbers, and punctuation and can be up to 255 

characters long. 

Label is also a termed used to refer to heading and titles in charts such as horizontal and 

vertical axes. 

 

Characteristics of Labels 

1. Always left aligned on entry to the worksheet. 

2. Can spill into adjacent cells. 

3. Can be a combination of numbers and text e.g. UNEB/2007, 1999/2000, 1GB.etc. 

4. Text entries can be up 255 characters long. 

Note: A constant value is data which s either numeric including a date/time or text. 

 

Saving a Workbook 

 

1. Click file menu. 

2. Click save or save as 

3. In the Save in list box, specify the location under which you want to store your file e.g. 

My Documents. 

4. In the file name box type the name of your file  

5. Click save 

 

Saving a Workbook on the floppy diskette 

 

1. Click file menu. 

2. Click save or save as 

3. In the Save in list box, Select 3½ floppy (A:) 

4. In the file name box type the name of your file. 

5. Click save 
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Differences between Save and Save As Commands 

 

Save and Save As commands work the same if you are saving a workbook for the first time, 

However, they work differently after saving your workbook. 

 

Use the “Save” command to save any changes/additional information you have made to your 

workbook. 

 

Use “Save As” command to save a workbook under a different name or location e.g. on a 

diskette (3
1
/2 Floppy A:) 

 

Closing a Workbook 

 

1. Click file menu. 

2. Click Close or click the close button in upper right corner of the document window 

 

Retrieving /Opening a Workbook 

 

1. Click file menu. 

2. Click Open 

3. In the “Look in” list box, specify the location under which your file is stored 

4. Click the file you want to open and Click open. 

 

 

Exiting Microsoft Excel 

 

1. Click file menu. 

 

2. Click Exit. 

 

 Or  

Click the close button in upper right corner of the Microsoft Excel Screen. 

Or 

Press ALT + F4 to quit Micros Excel. 

 

Selecting Data in a Worksheet 

 

A selection consists of the highlighted items on the screen that will be affected by the next 

command or action. 

 

Before carrying out most tasks in Excel such as formatting, copying, moving or deleting data, 

one must first select the data you want work with. 

 

The selection can be a single cell, range, entire row, column or worksheet. 

 

Selecting a Single Cell 

 

With a mouse, click the cell you want to select. 

Or 

With a keyboard, press the arrow keys to move to the cell you want to select. 
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Selecting a Range 

 

A range is a group/block of cells. A range may vary from a single cell, row, column, a 

rectangular block of cells or entire worksheet. 

 

Ranges are commonly when manipulating data in a worksheet. E.g. summation of data in a 

specified range or finding the average, minimum or maximum values from the specified 

range. 

 

To select a range, do the following:- 

 

With a mouse, click the first cell of range and then drag over the to last cell of the range. 

 

Or 

With a keyboard, use the arrow keys to move to the first cell of the range, press F8 to turn on 

the extension key and then press the arrow keys to extend the selection to include the cells 

you want to select. 

 

Selecting Ranges of Ranges (Non-adjacent Cells) using a mouse 

 

1. Select the first cell or range of cells.  

 

2. While holding down the ctrl key, click the additional cells or drag through ranges of cells 

you want to select. 

 

Selecting Ranges of Ranges (Non-adjacent Cells) using a Keyboard 

 

1. Select the first cell or range of cells. 

2. Press F8 to turn on the Extension key and then use arrow keys to extend the selection. 

3. Press Shift + F8 to keep the current selection and then move to another part of the 

worksheet to select another range. 

4. Repeat steps 1-3 to make more selections. 

 

Selecting Entire Row 

 

Click the row heading (row number) 

To select several rows, drag through the row headings. 

 

Selecting Entire Column 

 

Click the column heading e.g. A, B, C. 

To select several columns, drag through the column headings. 

 

Selecting Entire Worksheet 

 

Click the “select all” button located above the first row and left of the first column  

 

 A B C D 

1     

2     

Select All 

Button 
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Copying Data within the worksheet 

 

1. Select the cells you want to copy. 

2. Right Click the select cells 

3. Select the paste area (Click the upper most left cell of the paste area) 

4. Right Click and Choose Paste. 

 

Copying Cells and Data by Dragging 

 

1. Select the cells you want to copy. 

2. Point to the border of the selected cells  

3. Hold down the ctrl key and drag the cells to the new location on the worksheet. 

 

Note: To drag the selection to a different worksheet, hold down ctrl + Alt and then drag over 

a sheet tab. 

 

Cutting/Moving Cells and Data 

 

1. Select the cells you want to move. 

2. Right click the highlighted cells and from the Pop-up menu, Click cut. 

3. Right click, the paste area (Right Click the upper most left cell of the paste area) 

4. Choose Paste from the Pop-up menu (CTRL + V). 

 

Moving Cells and Data by Dragging 

 

1. Select the cells you want to move. 

2. Point to the border of the selected cells  

3. Drag the cells to the new location on the worksheet 

 

Note: To move the selection to a different worksheet, hold down Alt key and then drag over 

a sheet where you want the data to be moved. 

 

USING THE FILL COMMAND 

 

The fill command is used to copy or fill data to adjacent cells. 

 

To use the fill command, do the following: 

 

Drag the fill handle at the right most bottom corner of the selected cells to fill the data to 

adjacent cells. 

 

Clearing cells 

 

The Clear command on the edit menu clears the contents (Data), format, comments or all 

from the selected cells and leaves the cells within the structure of the worksheet. 

 

To clear cells do the following: 

1. Right click on the selected cells 

2. Click clear Contents 
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Deleting cells or Ranges of Cells 

 

1. Select the cell or range you want to delete. 

2. Right click on the selected cells 

3. Click Delete, the dialog box appears. 

4. Decide how you want to shift cells e.g. Up, left, right or down. 

5. Click Ok.  

 

 

 

 

Deleting an entire Row 

 

1. Select the row you want to delete. (The best way a row is to click on the row heading or  

     drag through the row headings) 

2. Right click in the row heading,  

3.From the Pop up menu,  Click Delete. 

 

Deleting an entire Column 

 

1. Select the column you want to delete. (The best way a column is to click on the column  

    Heading or drag through the column headings)  

2. Right click in the column Heading e.g. A, B, C etc 

3. From the Pop up menu, Click Delete. 

 

Deleting an entire Worksheet 

 

1. Right click the worksheet you want to delete e.g. Sheet1 

2. From the Pop-up menu, Click delete. 

Note: The Worksheet will be permanently deleted. 

 

FINDING AND REPLACING TEXT AND NUMBERS IN THE WORKSHEET 

 

1. In a worksheet, click any cell.  

 

2. On the Home tab, in the Editing group, click Find & Select.  

 

 

 

 

 

 

3. Do one of the following:  

 To find text or numbers, click Find.  

 To find and replace text or numbers, click Replace. 

 

4. In the Find what box, type the text or numbers that you want to search for. 

5. In the Replace with box., enter the or numbers you want to replace with 

6. Click Replace or Replace All button to replace the text or numbers. 

7. When done, Click close button to close the dialog box.. 

javascript:AlterAllDivs('none');
javascript:AppendPopup(this,'xldefWorksheet_1_1')
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Note: 

You can use wildcard characters, such as an asterisk (*) or a question mark (?), in your 

search criteria: 

 

 Use the asterisk to find any string of characters. For example, s*d finds "sad" and 

"started".  

 Use the question mark to find any single character. For example, s?t finds "sat" and 

"set". 

 

CHANGING VIEWS 

 

Microsoft Excel has modes you can use to view data in the worksheet. 

 

1. Normal View (default View). 

2. Page Layout View 

3. Page Break Preview. 

4. Custom views 

5. Full Screen View. 

 

To switch between Normal View and Page Break Preview, do the following: 

 

1. Choose View Menu 

2. Click the view you want e.g. normal or Page Break Preview 

 

Hiding/Minimizing a Ribbon 

 

To reduce screen clutter, some tabs are shown only when they are needed. When the Ribbon 

is minimized, you see only the tabs. 

 

Right-click the Ribbon, and then click Minimize the Ribbon. 

 

 

Displaying/Restoring a Ribbon Hiding a Toolbar 

 

Right-click the Ribbon, and then click Minimize the Ribbon. 

 

Note: 

To quickly minimize the Ribbon, double-click the name of the active tab. Double-click a 

tab again to restore the Ribbon. 

 

Keyboard shortcut:  To minimize or restore the Ribbon, press CTRL+F1. 

 

 

ZOOMING IN AND OUT OF THE WORKSHEET 

 

Zooming refers to the magnification or reduction in the screen display. Zooming displays a 

worksheet at different scales/sizes ranging from 25% - 400% 

 

To zoom in or out of the worksheet, do the following: 
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1. Click View Tab. 

2. Click zoom, the zoom Dialog box appears. 

3. Select the required magnification from the list or you can type a zoom size in the 

custom box. 

4. Click Ok. 

 
 

WORKING WITH FULL SCREEN 

 

Full Screen displays your worksheet in detail. In full screen mode, all window elements such 

as Tabs, Ribbon and status bar are hidden. 

 

To switch to Full Screen View, Click View Tab, click Full Screen view. 

 

To return to normal view, Press Esc/Cancel Key. 

 

DISPLAYING THE FORMULA BAR 

 

If you do not see the formula bar on the Screen, click View Tab, Click Formula bar.  

 

INSERTING CELLS 

 

You can insert blank cells above or to the left of the active cell on a worksheet. When you 

insert blank cells, Excel shifts other cells in the same column down or cells in the same row 

to the right to accommodate the new cells 

 

1. Select the cell or the range of cells where you want to insert the new blank cells. Select 

the same number of cells as you want to insert. For example, to insert five blank cells, 

select five cells. 

 

2. On the Home tab, in the Cells group, click the down arrow next to Insert, and then click 

Insert Cells.  

 
 

javascript:AppendPopup(this,'xldefActiveCell_1_1')
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ADDING/ INSERTING A ROW(S) 

 

1. To insert a single row, select either the whole row (Click in the row heading) or a 

cell in the row above which you want to insert the new row. For example, to insert a 

new row above row 5, click a cell in row 5.  

 

To insert multiple rows, select the rows above which you want to insert rows. Select 

the same number of rows as you want to insert. For example, to insert three new 

rows, you select three rows.  

 

To insert nonadjacent rows, hold down CTRL while you select nonadjacent rows. 

 

2. On the Home tab, in the Cells group, click the down arrow next to Insert. 

 

 
 

3. Click Insert Worksheet Rows. 

 

 
 

 

Note:  You can also right-click the selected rows and then click Insert. 

 

ADDIND/ INSERTING COLUMNS 

 

1.  To insert a single column, click a cell in a column to the right where you want to add a 

column. 

 

To insert many columns, select the same number of columns as the number of columns 

you want to insert. 

 

3.  The Dialog box appears 

 

4. Decide how you want to shift cells e.g. right, left up  

     or down. 

 

5. When done, click ok 
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3. On the Home tab, in the Cells group, click the arrow next to Insert. 

 

3.   Click Insert Sheet Columns. 

 

 
Note: 

 You can also right-click the selected cells and then click Insert. 

 

INSERTING WORKSHEETS 

 

1. Select the worksheet where you want to insert the worksheet 

2. Click Home Tab 

3. Click the down arrow next to insert 

 
4. Click insert Sheet.  

Or 

1. Right click a sheet Tab 

2. Click Insert from the shortcut menu, 

3. Choose Worksheet 

4. Click ok. 

   

INSERTING PICTURES/CLIP ART/SHAPES  INTO THE WORKSHEET 

 

You can insert or copy pictures and clip art into an Excel worksheet from many different 

sources, including downloading from a clip art Web site on the Internet. 

 

1. Click Insert Tab 

2. Click in the Illustrations group. 

 

3.   In the Clip Art task pane, in the Search for text box, type a word or phrase that 

describes  

      the clip art that you want, or type all or some of the file name of the clip art. 

 

4.   Click Go.  

5.   In the list of results, click the clip art to insert it. 

javascript:AppendPopup(this,'ofclipart_1_1')
javascript:AppendPopup(this,'OfTaskPane_2_2')
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SIZING A PICTURE 

 

Drag the picture handles (place holders) to size the picture.  

 

Note, Picture handles| place holders are small squares surrounding the picture when you click 

on it. Drag to size only when you see the mouse pointer turns into two headed arrows. 

 

MOVING A PICTURE 

 

Point to the picture you want to move, when you see the mouse pointer turn into 4-headed 

arrows; drag the picture to the new location. 

 

DELETING A PICTURE 

 

1. Select the picture you want to delete 

2. Press the delete key on the key board.  

 

FORMATTING CELLS 

 

Cells can be formatted when they are empty. The containing data. If empty cells are 

formatted, the data entered in these cells takes on the formats applied.  

 

To format cells do the following: 

 

1. Select the cells you want to format. 

2. Click Tab. 

3. Click the down arrow next to format menu,  

4. Click Format cells. 

     The format cells dialog box appears with the following options: 
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Number 

 

This is used to format cells containing numbers. Excel uses a general number format unless 

you specify otherwise. 

 

The general number format right aligns numbers and left aligns text entries. 

 

To format numbers, click number from the category and the make necessary settings as 

required and click ok. 

 

Alignment 

 

This refers to location of numbers and text within the selected cells. E.g. left, center, right or 

justify. 

 

There are to the two types of alignment: 

1. Horizontal alignment. 

2. Vertical alignment 

 

Horizontal Alignment 

 

Aligns numbers and text within the selected cells horizontally (General, Left, Center, Right or 

Justify) 

 

Horizontal Alignment includes the following: 

 

1. General – aligns text to the left and numbers to the right 

2. Left – aligns selected cells entries to the left. 

3. Center – aligns selected cells entries to the Center 

4. Right – aligns selected cells entries to the right 

5. Fill – repeats the contents of the selected cell entries until the cell is full. 

6. Justify – aligns text and numbers within the selected cells to the left and right. 

 

Vertical Alignment 

 

Aligns cell entries vertically e.g. to the Top, Center or bottom of the cell. 

 

Vertical alignment includes the following: 

1. Top – aligns the selected cell entries to the top. 

2. Center - aligns the selected cell entries to the Center of the cell vertically. 

3. Bottom - aligns the selected cell entries to the bottom of the cell. 

4. Justify – aligns text and numbers within the selected cells to the Top and bottom 

 

Text Wrap 

 

Displays long strings of text on multiple lines within a cell. i.e. limits long text within the 

cell. 

 

Orientation 
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Rotates the selected cell to the specified degree. You can specify the degree of rotation for 

the cell. E.g. 45
o
, 90

o
, 180

o
, -90

o
 etc. The default or Normal is 0

o
. 

 

Indenting  

 

This is used to specify a distance of text or numbers in a cell from the left border. 

 

MERGING/JOINING CELLS 

 

Centers or aligns or merges data that spans several rows or columns such as Column or Row 

headings into one cell. 

 

To merge/join cells do the following: 

 

1. Select the cells you want to merge/join. 

2. Right click the selected cells, From the Pop-up menu, Click Format Cells 

3. Click Alignment Tab/Button in the dialog box 

4. Click merge Cells 

5. Click ok.   

 

SHRINKING CELL ENTRIES 

 

Reduces the size of the data in a cell to fit without resizing the cell. 

 

Steps 

1. Right Click the cell you want to shrink 

2. From the Pop-up menu, Click Format Cells, The Format Cells Dialog Box appears 

3. Click Alignment Tab 

4. Shrink to fit 

5. Click Ok. 

 

FONT TAB 

 

Enables one to choose the font type/typeface, Style, Size, font Colour, Underline and other 

effects to the selected cells. 

 

The preview area in the Font dialog box shows a sample of what the formatted text will look 

like. 

 

Steps: 

1. Select the cells you want to format. 

2. Click Home Tab 

3. Click Format and then Click Format Cells. Dialog Boxes appears. 

3. Click Font Tab. 

4. Choose options e.g. Font, Font style, Font size, Colour, Underline etc. 

5. When done, Click ok. 

 

ADDING BORDERS 
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In MS-Excel, borders are added along specific edges of each cell in the selection. The 

particular edges are Outline, Left, Right, Top and Bottom. 

 

To add borders do the following: 

 

1. Select the cells you want to format. 

2. From the Home Tab, Click the down arrow next to Format, Then Click Format Cells,  

    The Format Cells dialog box appears. 

          

 

3. Click the Border Tab. 

4. Under presets, Click the Inside and Outline buttons to apply borders to all edges of the  

    selected cells. Or click the buttons under borders to apply borders to specific sides/edges  

    of the selected cells. 

REMOVING BORDERS 

 

1. Select the cells from which you want to remove borders. 

2. Click Home Tab, Click Format and then click format cells. Dialog Box appears. 

3. Click Borders Tab 

4. Click None. 

 

APPLYING PATTERNS 
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Controls the shading of the selected cells in the worksheet or appearance of the selected 

graphic or object. 

 

You can format text boxes, ovals, arcs, rectangles, picture borders and lines. The options 

available depend on the object you have selected. 

 

To apply cell Shading and patterns to the selected cells, do the following 

 

1. Right Click the selected cells 

2. Click Format cells, the format cells dialog box appears 

3. Click the Patterns Tab. 

4. Under Cell Shading, Select the Colour and Pattern you want 

5. When done, click ok. 

 

REMOVING PATTERNS AND SHADING 

 

1. Select the cells from which you want to remove the shading  

2. Right Click the selected cells and from the Pop-Up menu, Click format Cells. 

3. Click Fill Tab 

4. Click No Colour. 

6. Click Ok. 

 

PROTECTING WORKSHEETS AND WORKSHEET ELEMENTS 
 

To prevent a user from accidentally or deliberately changing, moving, or deleting important 

data from a worksheet or workbook, you can protect certain worksheet or workbook 

elements, with or without a password. You can remove the protection from a worksheet as 

needed. 

 

Protection determines whether cells will be locked or whether their formulas will be hidden 

when you protect the worksheet.  

 

Locked cells cannot be edited when the worksheet is protected. Hidden cells display their 

values but no formula appears in the formula bar. 

 

To protect a Worksheet do the following: 

 

1. Select the worksheet that you want to protect.  

2. To Lock/unlock any cells or ranges that you want other users to be able to change, do 

the following:  

 

1. Select each cell or range that you want to unlock.  

2. On the Home tab, in the Cells group, click Format, and then click Format Cells.  

 

 
 

javascript:AppendPopup(this,'xldefWorksheet_1_1')
javascript:AppendPopup(this,'XldefPassword_2_2')
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3. On the Protection tab, Check (lock) or clear the Locked check box to unlock to 

cells, and then click OK. 

 

To hide any formulas that you do not want to be visible, do the following:  

 

 In the worksheet, select the cells that contain the formulas that you want to hide.  

 On the Home tab, in the Cells group, click Format, and then click Format 

Cells.  

 On the Protection tab, select the Hidden check box, and then click OK. 

 

4.     On the Review Tab, in the Changes group, Click Protect Sheet.  

         

The Protect sheet Dialog Box appears.  

 

5.  To prevent other users from removing workbook protection, in the Password box, 

type a password, click OK, and then retype the password to confirm it. 

 

6.  In the Allow all users of this worksheet to list, select the elements that you do not 

want users to be change. 

7.  Click ok. 
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PROTECTING WORKBOOKS 

 

1.   Click the Review Tab 

2.    Click Protect Workbook 

 

 
  

2.    Under Protect workbook for, do one or more of the following:  

 To protect the structure of a workbook, select the Structure check box.  

 To keep workbook windows in the same size and position every time the 

workbook is opened, select the Windows check  

 

3.    To prevent other users from removing workbook protection, in the Password (optional)  

       box, type a password, click OK, and then retype the password to confirm it. 

 

UNPROTECTING WORKSHEETS   

1. On the Review Tab, in the Changes group, Click Protect Sheet.  

 

2.  In the Allow all users of this worksheet to list, select the elements that you want 

users to be able to change.  

 

 
 

3.      In the Password to unprotect sheet box, type a password for the sheet, click OK, 

and then retype the password to confirm it.  
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Note: 

Passwords are case sensitive and thus great care must be taken when entering a 

password. 

 

ADJUSTING COLUMN WIDTH 

 

1. Click a cell in a column (for a single cell) or select an entire row to change the width of     

all Columns in the worksheet. 

2. Click Home Tab, Click Format and then choose Column width. Dialog Box appears. 

 

    
 

3. Enter the width you want in the column width box. 

4. Click ok. 

 

The standard/default column width is 8.43 points (64pixes). 

 

Note: 

 

You can adjust the column width by dragging the column border to the right of the column 

heading until the column is the size you want. 

 

You can also adjust the column width for auto Fit by Double Clicking the column border to 

the right of the column heading. 

 

STANDARD COLUMN WIDTH 

 

Changes the width of all columns in the active worksheet that have not been individually 

changed. 

 

You can enter an integer or decimal fraction from 0 – 255. This number represents the 

number of characters that can be displayed in a cell for the current font or size. 

 

HIDING ROWS OR COLUMNS 

 

1. Select the Row (s) or Column (s) you want to hide 

2. Click Home Tab, Click Format, Under Visibility, point to hide & unhide 

3. Click Hide Rows or Columns. 

 

UNHIDING ROWS OR COLUMNS 

 

1. Select the Row (s) or Column (s) you want to unhide 

2. Click Home Tab, Click Format, Under Visibility, point to hide & unhide 

3. Click Unhide Rows or Columns. 
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ADJUSTING ROW HEIGHT 

 

The row height automatically changes according to the size of the data in it. However, one 

can change the row height as desired. 

 

To adjust the row height, do the following: 

 

1. Select the only one cell in the row to change the height for the entire row. To change the  

    height of all rows in a worksheet, select one entire column or entire worksheet. 

 

2. Click Home Tab, Click Format and then choose Row Height. Dialog Box appears. 

 

    
 

4. Enter the integer or decimal fraction representing the row height in the Row height box 

    in points e.g. 15, 20, 30 and so on. The default or standard row height is 15 points. 

5. Click ok. 

 

Standard Row Height 

 

Standard row height varies according to the font size. It returns each row in the selection to 

the standard height for the font within the row. 

 

If the row contains more than one font, the standard row height is adjusted for the largest 

font. 

 

To apply standard row height, do the following: 

 

1. Select the rows you want to format. 

2. Click Home Tab, Click Format 

3. Click AutoFit Row height 

 

RENAMING WORKSHEETS 

 

1. Right click the worksheet you to rename. 

2. From the Pop-Up Menu, Click Rename 

3. Type the name of the worksheet and press enter. 

 

Or 

 

1. Select the sheet you want to rename 

2. Choose Home Tab 

3. Click the down arrow next to Format 

4. Click Rename Sheet 

5. Type the sheet name and press enter. 
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MOVING OR COPYING A SHEET 

 

1. Right click the worksheet you to Move or Copy 

2. From the Pop-Up Menu, Click Move or Copy, Dialog Box appears 

 

 
 

4. Select the sheets you want to move and click ok 

 

5. To copy a sheet, Click create a copy and click ok. 

 

 

 

DELETING WORKSHEETS 

 

Right the Sheet you want to delete and then click delete 

 

 

WORKING WITH PANES AND TITLES 

 

Panes are screen portions. Panes allow the user to view different areas of a large worksheet 

simultaneously. You can split a window into two panes horizontally or vertically. 

 

With a vertical split, the panes scroll together vertically but independently horizontally. 

 

With a horizontal split, the panes scroll together horizontally but independently vertically. 

 

If you split a window both vertically and horizontally, you can display four panes. 

 

SPLITING A WINDOW INTO TWO PANES 

 

1. Select a column (for a horizontal split) or a row (for a vertical split). 

2. Click Window Menu 

3. Click Split 
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Alternatively, you can split a window into two panes by dragging the horizontal or vertical 

split box to the desired position. These boxes are found on the Vertical and horizontal scroll 

bars. When you position the mouse pointer on a split box, the pointer changes into a two – 

headed arrow. 

 

SPLITING A WINDOW INTO FOUR PANES 

 

1. Select a cell to the left and top of which you want the split to occur (for both Vertical and  

    Horizontal split)  

2. Click View Tab 

3. Click Split. 

 

Note: 

You can adjust split panes by dragging the split bar to the position you want. 

 

If you want to display another copy of your worksheet in its own window, Click View Tab, 

Then Click Arrange All. 

 

REMOVING SPLITS 

 

1. Click View Tab 

2. Click Split. 

 

Alternatively, Double Click any part of the split bar to remove it. 

 

FREEZING PANES AND TITLES 

 

Freezing panes keeps row and column headings/titles on the screen while scrolling through a 

long list of data on the worksheet. 

 

You can split a window into panes first and then freeze panes or you can freeze worksheet 

titles in a single step. 

 

Freezing Titles does not affect printing. 

 

FREEZING VERTICAL/HORIZONTAL TITLES 

1. Select a row below the titles (for a horizontal split) or a column to the right of the titles (for  

     a vertical split). 

2. Click View Tab 

3. Click Freeze Panes.  
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FREEZING BOTH HORIZONTAL AND VERTICAL TITLES 

 

1. Select the cell below the titles and right of the columns you want to freeze.  

2. Select View Tab 

3. Click Freeze 

 

All rows above the selected cell and columns to the left of the selected cell will be frozen. 

 

Note: 

 

1. If you split the window before freezing panes, the panes are frozen at their current location,  

    not at the active cell. 

 

2. To freeze a pane if the window is already split, select Window Menu, Click freeze Panes. 

3. If you split window before choosing the Freeze Panes command, the split remains  

    otherwise the window returns to normal. 

 

UNFREEZING PANES AND TITLES 

 

1. Click View Tab 

2. Click the down arrow next to Freeze Panes 

2. Click Unfreeze Panes. 
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WORKING WITH FORMULAS 

 

A formula is a set of instructions for performing a calculation. A sequence of values, cell 

references and operators in a cell that together produce a new value. 

 

TYPES OF FORMULAS 

 

There are three types of formulas in Microsoft Excel worksheets. These include: 

 

1. Arithmetic formulas. 

2. Logical formulas 

3. Text Formulas 

 

ARITHMETIC FORMULAS 

 

These are formulas used to evaluate numbers. They are the most commonly used type of 

formulas. 

 

ARITHMETIC OPERATORS 

 

1. + -  Addition 

2.  - -  Subtraction 

3. / - Division 

4. * - Multiplication 

5. ^ - Square 

6. % - Percentage 

 

LOGICAL FORMULAS 

 

These are formulas used for comparing values. The comparison operators include: 

1.  = - Equal to 

2. < - Less Than 

3.  > - Greater than 

4. =< - Less than or Equal to 

5. => - Greater or Greater than 

6. <> - Less or Greater  

 

TEXT FORMULAS 

 

These are formulas used for evaluating text. The text operator is &. 

 

Example: 

= “New” & Vision” and then press enter key. 

= Newvision. 
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REFERENCE OPERATOR 

 

1. Full colon [:] 

 

 

UNION OPERATOR 

 

This is used to combine a number of values or cell addresses to obtain the total sum. The 

union operator is a Comma (,). 

 

Example: =Sum(A1,B2, C4,D9) 

 

HOW TO ENTER A FORMULA 

 

1. Select a cell in which you want to enter the formula. 

 

2. Type an = or + sign. (all formulas in Ms-Excel always begin with a plus or Equal sign.  

    These signs tell Excel that all data that follow these signs is a formula. Please avoid     

    starting your entry with a “+’’ or “=’’or “-’’ sign if you are not entering a formula. 

 

3. Type the cell reference/address, values, operators, parenthesis, and functions immediately  

     after the = or + sign. 

 

4. Press Enter Key to complete the formula.   

 

 

Examples of some formulas 

 

1.  =Sum(A2:E12) - Produces the Total sum of all cells spanning from A2 through  

       E12. 

 

2.  =(F37/12)*30  - Produces the result of dividing the value in F37 by 12 then  

       Multiplying it by 30.  

 

3.  =(B4^2)  - Produces the result of squaring the value in B4. 

 

 

PARTS OF A FORMULA 

 

A formula can begin with an equal sign or a plus sign. These signs are immediately followed 

by desired sequence of values, cell references, names, functions or operators. 

 

A formula calculates a value from the existing values. The existing values can be constants 

that are entered as part of the formula itself or the can be other cells that are referenced or 

named in the formula  

 

The operators and functions specify the type of calculation you want Excel to perform in the 

formula. 
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CELL REFERENCES AND REFERENCING 

 

A reference is the location of a cell on a worksheet. For example, the cell reference B5 refers 

to a cell in Column B row 5. 

 

References make formulas flexible. You can use the same value in many formulas by 

entering the value in the cell and entering the reference of that cell in the formula. If you 

should change the value in the cell, Excel automatically updates all formulas using the value. 

 

TYPES OF REFERENCES 

 

Micro Excel recognizes three types of references. These include: 

 

1. Relative Reference 

2. Absolute Reference 

3. Mixed Reference. 

 

RELATIVE REFERENCE 

 

This is the references of a cell regardless of its location on the worksheet. A5, K95, G27. 

Or 

Relative reference is the normal cell reference that is automatically adjusted when a formula 

is copied that refers to that cell. 

 

 Relative reference tells Excel how to find another cell starting from a cell containing the 

formula. It is like giving some one direction e.g. go up 2 floors and turn right.  

 

Relative references are used to copy formulas across rows.      

 

ABSOLUTE REFERENCE 

 

This is a reference of a cell based on its exact location on the worksheet.  

or 

Absolute reference is a reference of a cell that Excel cannot automatically adjust. 

 

Absolute references are indicated/designated by adding a dollar sign ($) before the Column 

letter and Row number. Examples of absolute references: $D$9, $G$24, $B$2.  

$B$2 is the same as B2. 

 

Absolute references are used to copy formulas downward the column. 

 

Absolute reference is like a street address e.g. Plot 30 Kampala Road. It tells Excel how to 

find a cell based on the exact location of that cell on the worksheet. 

 

MIXED REFERENCE 

 

Is a reference that uses an absolute column reference and a relative row reference and Vice-

versa. 

or 
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Is a cell reference that has a either a row or column made Absolute but not both using a dollar 

Sign ($). 

 

Examples of mixed references are $A2 or A$2, which is the same as A2. 

 

 

FORMULAS AND ARITHMETIC OPERATORS 

 

Apart from performing arithmetic operations on numbers typed directly into a formula, one 

can enter cell references/addresses of the cells containing numbers into the formula instead of 

numbers themselves. Excel then performs the calculations basing on whatever values are 

contained in these cells. 

 

For example: 

 

If you have numbers 500 in cell A1 and 320 in A2 and you want the sum of these two values 

in cell A4, Enter a formula in Cell A4 that refers to the cells A1 and A2, instead of 500 and 

320. 

 

Formulas always begin with an equal (=) sign or a plus sign (+). In our example therefore, the 

formula to be entered in cell A4 would be =A1+A2. 

 

The cell such as A4 in which the formula is entered is called the formula cell. 

 

When you complete the entry, Excel displays the result of the formula in the current cell and 

the formula itself is displayed in the formula bar. 

 

Arithmetic formulas contain numbers and operators. They are entered into cells like any other 

entry. 

 

You can also have a combination of cell references and numbers in a formula. 

 

AUTOMATIC RECALCULATION 

 

When you use cell references in a formula, you instruct excel to use whatever numbers which 

are currently in those cells to give you the result. After you have entered a formula, you can 

change the numbers at will; Ms-Excel remembers your instructions and automatically re-

calculates them, generating a new result. This feature is known as Automatic Re-

calculation.  Which means that any time you change the values in the cell that is referenced 

in formulas in other cells (be it directly or indirectly), the result of the formulas are 

automatically re-calculated. 

 

 

THE ORDER OF CALCULATION 

 

Formulas that contain more than one operator are a subject to strict rules governing the order 

of calculation. In some cases these rules cause Excel to calculate a formula in a sequence 

other than the one expected thus generating unintended results. 
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The order of precedence among arithmetic operators is: 

  

1. Exponentiation 

2. A minus sign or a plus sign occurring at the beginning of the formula. 

3. Multiplication and division. 

4. Addition and Subtraction. 

 

Example: 

 

The formula = B1 +B2/4 will produce a result diving B2 by 4 and then adding B1. 

 

If you want the operations within a formula to be carried out in sequence other than one 

dictated by the rules of precedence, then you need to use parenthesis (brackets). In the above 

example therefore, if you want the sum of B1 + B2 divided by 4, you should enter the 

formula: =(B1+B2)/4. 

 

REFERENCING BLOCKS OF CELLS  

 

A block is a group of cells in a worksheet. It sometimes known as a Range.  

 

A block can range in size from a single cell to an entire worksheet. It can contain several cells 

within a row, column or cells in multiple rows and columns. 

 

A block is designated by the address of the top left corners and the lower right corners 

separated by two periods or a full colon [:]. 

 

If the cells are in the same column the address may be read as the top cell and the bottom cell. 

 

If the cells are in the same row, the address may be read as the left most cell and the right 

most cell.      

 

Blocks are used in two situations: 

1. In formulas 

2. In commands. 

Examples of blocks: 

 

1. D5 - Single cell block 

2. C4:C9 - A block of cells within column C spanning from C4 through C9. 

3. B1:E4 - Includes cells spanning through row 1 – 4 and columns B through E. 

 

You can also take the two cells on the other diagonal when specifying a block e.g. B4:E1 

instead of B1:E4. 

 

Note: 

 

As you manipulate worksheets e.g. enter a formula, sometimes you may want to refer to so 

many cells at a go (e.g. totaling values in 100 cells). It becomes tedious if you are to refer to 

each cell individually. Microsoft Excel provides a way of referring to a group of cells at a 

time.   
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INSERTING CELL OR RANGE REFERENCES INTO A FORMULA 

 

Ms-Excel provides two ways of inserting/including cell references in a formula.  

 

You can enter a cell or range reference by typing them into the formula while in enter mode 

or by selecting the cells/range of cells in point mode. 

 

Using the Point Mode 

 

1. Type an Equal sign or a Plus sign at the beginning of the formula, followed by a function,  

    Parenthesis, Cell address or an operator. 

 

2. With a mouse simply click on the cell or drag over the range that you want to reference. As  

     Soon as you move cell pointer you are placed into point mode. As you select cells or 

     range, the address of the selected cells is inserted into the formula. Otherwise use the  

     arrow keys to select cells or range that you want to reference.   

 

3. if you want to keep adding cell references to the formula, type another operator and  

    Continue typing or point to another cell. 

 

1. When done entering the formula, press enter or click the enter box. 

 

COPYING A FORMULAR 

 

1. Select the cell containing the formula. 

2. Click Edit Menu, Click Copy 

3. Select the cells where you want to copy formula. 

4. Click Edit Menu, Click Paste. 

Alternatively, select the cell containing formula and then drag auto fill handle to copy the 

formula to the rest of the cells. 

 

USING FUNCTIONS 

 

A function is a pre-defined formula. 

 

Examples of Functions include: 

 

1. SUM 

2. AVERAGE 

3. PRODUCT 

4. MAX (MAXIMUM) 

5. MIN (MINIMUM) 

6. IF 

7. STD. DEV. 

8. RANK 

9. VLOOKUP 

10. COUNT 

11. COUNT IF 

12. COUNTA  

13. COUNT BLANK 
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14. COLUMNS 

15. ROUND  

16. MEDIAN 

17. SUM IF 

 

 

SUM 

 

Sum adds all the numbers in the range of cells. 

 

Example: =Sum(Range) e.g. =SUM(C2:C9) gives the total sum of cells in column C 

ranging from C2 to C9. 

 

 

AVERAGE 

 

Determines/Returns the average value of the selected cells. 

 

Returns the average (Arithmetic mean) of its arguments which can be numbers or names or 

references that contain numbers. 

 

Mean refers to the Total sum divide by the number of elements. 

 

Example: = AVERAGE(Range) 

 

PRODUCT 

Multiplies all the numbers given as arguments and returns the product. 

 

Example:  =PRODUCT(Arguments or numbers) 

 

MAX 

Returns the Maximum/largest number/value from a set of values. 

 

 Example: = MAX(numbers) 

 

MIN 

Returns the lowest value in the set of values. 

 

 Example: = MIN(numbers) 

 

IF 

Returns to one value if a condition you specify evaluates to a True and another value if it 

evaluates to False.  

 

COLUMNS 

Returns the number of columns within the list of arguments. 

Example: =COLUMN([Reference])  

 

COUNT 

Counts the number of cells in a range that contain numbers.  
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COUNTA 

Counts the number of cells in a range that are not empty 

 

COUNTIF 

Counts the number of cells within the range that meet the given condition/criteria. 

 

Example: COUNTIF(Range, criteria) e.g. =COUNTIF(B2:B10, “>60”) gives cells within the 

range that have values greater than 60. 

 

ROUND 

 

Rounds a number to a specified number of digits.  

Example: =ROUND(number, num_digits) 

 

MEDIAN 

 

Returns the median, or the number in the middle of the set of given numbers. 

Example: =MEDIAN(number1, [number2],….) 

 

RANK 

 

Returns the rank of a number in a list of numbers: its size relative to other values in the list. 

Example: RANK(number, ref, [order]) 

e.g. =RANK(B2, $B$2:$B$11,0), ranks numbers in the list according to  

 

VLOOKUP 

 

Looks for a value in the leftmost column of a table, and then returns a value in the same row 

from a column you specify, By default, the table must be sorted in ascending order. 

 

Example: VLOOKUP(Lookup value, Table of Array, Col_Index_num, [range_lookup]) 

 

 

MICROSOFT EXCEL ERROR MESSAGES 

 

These are errors which occur when a wrong formula, function, operand or argument is 

entered into an excel cell. 

 

If Excel cannot properly evaluate a worksheet formula or function, it will display an error 

value such as #REF, #NULL, #DIV/0, in a cell where the formula is located. 

 

The error value itself plus the error option button, which is displayed in cells with error 

formulas, gives some help in identifying the problem about the problem. 
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COMMON EXCEL ERROR MESSAGES AND THEIR MEANING 

 

1. #NAME?  –  Excel does not recognize text in the formula. 

 

2. #DIV/0!  –  Formula is trying to divide a number by 0 or an empty cell. 

3. #NULL!  –  A space was used in the formula that references multiple  

Cells/ranges. 

4. #N/A! –  A formula refers to a value it cannot find. Probably pointing to an  

empty cell. 

 

5. #VALUE  –  Wrong type of operand/function or argument is used. 

6. ######  -  Cell/column is not wide enough to display the contents designated  

                                       for it. 

 

7. #REF!  – A cell reference is not valid or A formula refers to a missing cell. 

or a cell which is not valid. This is often displayed when you delete 

cells which are referenced in a formula. 

 

 

MANAGING LISTS 

 

A list is a labeled series of worksheet rows which contain sets of data. A list can be used as a 

database, where columns are fields and rows are records. 

 

Microsoft Excel provides a powerful set of commands to make it easy to manage lists. You 

do not need to do anything special to make your list a database. When you perform a database 

task such as sorting data, Ms-Excel automatically recognizes your list as a Database. 

 

- Columns in a list are called fields in a database. 

- Column headings/Labels in a list are called field names in a database. 

- Each row in a list is called a record in a database. 

 

SORTING DATA 

 

Sorting simply means arranging data. Sorting arranges rows in a list according to the contents 

of the selected columns. 

 

To sort data, do the following: 

 

1. Select a single cell in the list you want to sort. 

2. Click Data Tab. 

3. Click Sort, the sort dialog box appears  

4. In the Sort by box, select the column you want to use to sort the data and then select the  

    sort order e.g. Ascending (A-Z) or Descending (Z-A) 

5. Click ok. 
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You can click Add Level tab for more sort options. Otherwise click delete level to remove the 

level. 

 

 
 

Note: 

 

1. Then By Box 

Enables one to specify the order in which to sort rows if there are duplicate items in the 

previous column you specified. Select the sort order for each box to determine the 

arrangement of data. 

 

2. My List has a Headers 

 

Determines whether the header row/first row of your list is excluded or included when 

data is being sorted. If your list has column labels/headings, the header row option is 

selected for you. And the first row is excluded.  

 

    Select no Header Row option button to include the first row in the sort. 

 

3. If you sort by one column, rows with duplicate items in the column remain in their original  

    order. 

 

4. Rows with blank cells in the sort column are placed last in the sorted list. 

 

5. If you sort by more one column, Rows with duplicate items in the primary column are  

    sorted according to the second column you specify. Rows with duplicate items in second  

    column are sorted according to the third column you specify. 

 

3. It is possible to sort only selected cells. 
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WORKING WITH DATA FORMS 

 

A data form provides a simple way to view, change, add and delete records from the list or 

Database or to find specific records based on the criteria you specify. 

 

When you choose the Form command on the Data Menu, Microsoft reads your data and 

creates a Data Form dialog box. 

 

When you enter or edit data in these fields, Excel changes the corresponding cells in your list. 

 

To use a data form, your list must have column headings/labels. The data form dialog box 

automatically expands to display all the fields in your list up to 32 fields. 

 

To use the Data Form, do the following: 

 

1. Click one cell in the list. 

2. Click Data Menu. 

3. Click Form, the data form dialog box appears. 

 

Adding a Record Using the Data Form  
 

1. In the Data Form Dialog Box, Click New Button. 

2. Type the fields for the new record and then press tab key to move to the next field. 

3. When you finish entering the data, Press Enter. 

4. Repeat steps 1-3 to add more records. 

5. When done, Click the Close button to return to the worksheet data. 

 

Note: 

 

The new records are inserted at the bottom of the list. 

 

Browsing through the List 

 

1. To move forward, Click Find Next button. 

2. To move Backward, Click Find Prev button 

 

You can also use the scroll bars to move/browse through the list. 

 

Finding Records that meet search Criteria 

 

1. Click the Criteria Button in the Data Form Dialog Box. 

2. In the Edit Boxes, type the criteria you want to use to search the list. 

 

You can also enter comparison operators with the Criteria such as >, <, <=, >=, =, and ? or *. 

 

3. Click the Find Next or Find Prev Button. 
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To locate other records in the list, click the clear button to remove the current criteria and 

then enter a new criterion. 

 

4. When done, Click Close button. 

 

Regaining Access to the entire List 

 

1. Click the Criteria button 

2. Click the Clear button 

3. Click the Form button. 

 

 

FILTERING DATA 

 

Filtering means extracting records/data from a list based on the specified criteria. Filtering 

enables you to find and work with a subset of the data in your list.  

 

Filtering displays only rows that contain a certain value or that meet a set of criteria while 

hiding the other rows. 

 

Microsoft Excel provides two commands for filtering data. These include: 

 

1. Auto Filter command 

2. Advanced Filter Command 

 

USING AUTO FILTER 

 

This applies Drop-Down arrows directly to the Column Labels/headings in the List. You can 

then open the arrow buttons to select the item you want to display from the list. 

 

To use Auto filter, Your List/Data must have Column Labels/Headings. 

 

To use Auto Filter, Do the following: 

 

1. Select a cell in a list you want to filter. 

2. Click the Data Menu. 

3. Point to Filter and then click Auto filter. Ms- Excel inserts Drop-Dowm Arrow buttons  

    next to each Column Heading in the List. 

 

4. Click the Drop-Down arrow in the column that contains the data you want to display. 

5. Select the item you want to display. 

 

REMOVING AUTO FILTER 

 

- Click the Arrow button next to the column you filtered and then click All from the list. 

 

- To redisplay all rows in the filtered list, Click data menu, Point to filter and then click Show  
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   All. 

- To remove the Auto Filter arrows from a list, Select Data Menu, Point to Filter and then  

   Clear the Auto filter. 

 

USING CUSTOM FILTER 

 

Auto filter inserts drop down arrows next to the column heading. To filter data using auto 

filter, do the following:   

 

1. Click the drop down arrow next to the column you want to filter. 

2. Click custom filter 

3. Select the condition you want to use to filter the data e.g. equal to, Less than etc. 

4. Click Ok. 

 

FILTERING A LIST USING ADVANCED FILTER 

 

Advanced filter enables one to find rows by using a more complex criterion. One can display 

only rows that meet all the Criteria specified. 

 

A criteria Range is the containing a set of conditions that you use to filter data in a list. It 

consists of one row that contains the criteria labels and at least one row that defines the 

search conditions. 

 

 

To use Advanced filter do the following: 

 

1. Insert several rows at the top of your worksheet. 

2. In one blank row, type the Column Headings you want to use to filter the data in the list. 

3. In the row below the Column Headings, type the Criteria you want to use to filter the data. 

4. Select the data you want to filter. 

5. Click the Data Menu. 

6. Point to filter, Click advanced filter, The advanced filter dialog Box appears. 

7. Select options as required. 

8. When done, Click Ok. 

Options in Advanced Filter Dialog Box 

 

1.  Action 

 

    - Filter the List in Place: This hides the Rows that do not meet the criteria. 

 

     - Copy to another location: Copies the filtered data to another location on the same  

        Worksheet or another worksheet. 

 

2.  List Range: Specifies the range containing the Criteria. 

 

3.   Copy To: Specifies a range of cells to which to copy the rows that meet the criteria you  
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      Specify. It is active only if you select the copy to another location button. 

 

4.   Unique Records Only: Displays unique rows that meet the criteria and excludes rows  

       that contain the duplicate items.  

 

      If you do not specify a criteria range, this option hides all duplicate rows in the list. 

 

SUBTOTALING DATA IN THE LIST 

 

One way to analyse data in a list is to sub-total the data. The subtotals command on the data 

menu inserts the subtotal rows in list, summarizing the data any way you choose. 

 

When you insert the subtotals, Ms-Excel automatically inserts the Grand total row at the 

bottom of the list. 

Before you sub-total the data, note the following: 

 

1. The list must have column labels/headings and must be sorted first. 

2. Choose the data you want to subtotal. 

3. Choose one or groups to define the subtotals. 

4. Choose the subtotal function. E.g. if you want to add up values, choose SUM. 

 

 

To subtotal the data, do the following: 

 

1. Sort the list by the column for which you want the sub Totals. 

2. Select a cell list you want subtotal. 

3. Click Data Menu. 

4. Click subtotals. 

5. In the At Each Change In Box, select the column containing the groups you want to  

    Subtotals for. 

6. In the use Function Box, select the function you want to use to summarise the data. 

7. In the Add Subtotals to Box, select the column containing the values you want to  

    summarise. 

8. When done, Click ok 

 

Options in the sub Totals Dialog Box 

 

At Each change In Box: Specifies the column that contains the groups you want Subtotals  

for. The column must be the one you used to sort the list. 

 

Use Function: Calculates the subtotal using the function you select. The computed Subtotals 

appear in the Add Subtotals To box. 
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Add Subtotals To: Specifies a column in which you want the subtotals to appear. 

 

Replace Current Subtotals: Replaces all subtotals in the list with the new subtotals you  

select.. Clear this box to keep the current subtotals and insert new ones. 

 

Page Break Between Groups:  Automatically inserts a page break proceeding each group of  

data that you subtotal. 

 

Summary Below Data: Places the summary Rows and Grand Total row below the above  

associated data. Clear this option to insert the Subtotal rows and Grand Total Rows their  

detail data.. 

 

Remove All: Removes all the subtotals from the current list. 

 

REMOVING SUBTOTALS FROM A LIST 

 

1. Select a cell in the List you want to remove the Subtotals. 

2. Click Data Menu. 

3. Click Subtotals 

4. Click the remove all Button. 

5. Click ok.  

 

CHARTS/GRAPHS 

 

A chart is a graphical representation of worksheet data. The chart helps to analyse and 

compare data or put attention to particular aspects of your data. 

 

TYPES OF CHARTS 

 

There are about 14 types of charts that can be created ii Microsoft Excel. These include: 

1. Column  

2. Bar  

3. Line  

4. Pie  

5. Doughnut 

6. XY (Scatter) 

7. Surface 

8. Bubble 

9. Stock 

10. Area 

11. Cylinder 

12. Cone 

13. Radar  

14. Pyramid 

 

CATEGORIES OF CHARTS 

 

There are 2 categories of charts or graphics in Microsoft. These are include: 

1. Embedded Charts 

2. Chart sheets. 
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EMBEDDED CHARTS 

 

An embedded chart is a chart that appears on the same sheet with the data it is created from. 

 

Embedded charts are ideal for reports or other documents in which one wants to show a chart 

within the context of the worksheet data. 

 

CHART SHEETS 

 

A chart sheet is a chart that appears on a separate sheet from the data it is created from. 

 

A chart sheet is automatically inserted into the workbook to the left of the worksheet it is 

based on. 

 

A chart sheet is suitable for presentation and training purposes, such as handouts, or 

enhancing printed material such as Newspaper articles and advertisements. 

 

Both embedded and chart sheets are linked to the worksheet data they were created from and 

both are updated whenever you save or update the worksheet. 

 

PLOTTING A CHART 

 

1. Select the data you want to plot. 

2. Click Insert Tab 

3. Click the chart wizard button on the Insert Tab, the chart wizard dialog box appears 
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4. Select the type of chart you want. 

 

PARTS OF A CHART  
 

                         Chart Title 

 

            

            

            

            

            

            

                       

                           

 

 

 

 

 

 

 

 

                 Legend 

 

 

 

FORMATTING A CHART 

 

After creating a chart and adding some chart items, such as Chart Titles, Grid lines, Axis 

Titles, Legends etc. you can format the entire chart area including data series and plot area or 

one chart item at a time. 

 

The chart area 

This is the area surrounding the entire chart just outside the plot area. 

 

The Plot area 

Is the area of the chart where data is plotted. 

 

When you point at any chart item, Microsoft Excel flashes a message telling you what the 

item is and when you click on it, its name appears in the formula bar in the Name box. 

 

Plot Area 

Y Axis 

Title 

Y Axis 

Value 

Data Series 
X Axis Title Chart Area 
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To format an item, Click it and click it again to ensure only one item is selected at a time and 

then right click it and from the Pop-menu, choose the appropriate command. E.g. to format 

the Legend, right click on it and choose format Legend.  

 

For each item you select, Microsoft Excel presents a Dialog box with appropriate formats. 

Click on each Tab that represents the format you want and make ant necessary settings.  

 

 

 

When done, click ok.  

 

USING GRADIENT,TEXTURE, PARTNER OR PICTURES IN THE CHART. 

You can use gradient, Texture, Partner or picture to format Data makers/series in Column, 

chart, Bar chart, area chart, Bubble chart, Line chart or in the plot area and chart area to 

enhance the appearance of your chart. 

 

Steps 

 

1. Right click on the chart item you want to format e.g. Chart area, Plot area, Data series or 

Data Point/Maker or Legend. From the pop up menu, click for example Format chart 

area. 

 The dialog box will appear. 

2. Click Fill effects, the Fill effects dialog box appears  

3. Click the required Tab e.g. Gradient, Texture, Partner or Pictures. 

4. Select the options you want, and then click ok. 
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ADDING GRADIENT IN THE CHART 

 

1. Click Fill button 

2. Click gradient Tab. 

3. Select options you want  For example: 

-     Colours (one, Two or Presets) 

- Shading Styles 

- Variants 

4. When done, click ok. 

 

 

ADDING TEXTURE IN THE CHART 
 

1. Click Fill button 

2. Click Texture Tab. 

3. Select options you want 

 

4. When done, click ok. 
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ADDING PARTNERS 

 

1. Click Fill button. 

2. Click Partners Tab. 

3. Select options you want. E.g. Foreground and Background Colours. The sample area 

shows the selected partner.  

4. When done, click ok. 
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USING PICTURES IN A CHART 

 

1. Click Fill button. 

2. Click Picture or texture fill 

3. Click Clip Art  

4. Click Select Picture  

5. In the Look in box, click the drive, folder, or Internet location that contains the 

picture, and then double-click the picture you want. The picture appears in the sample 

box. 

6. Click Ok. And then Ok again to apply the picture in the chart. 
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ADDING OR CHANGING CHART ITEMS 

 

You can add or change some chart items after creating a chart such as Titles, Legend, Data 

Labels, Gridlines, and Data Tables etc. 

 

Procedure 

 

1. Select the Chart 

2. Click Layout Tab 

3. Click chart option you want to add or change e.g. Chart Title, Legend, Data Labels, 

Axis Titles etc 

4. When done, click ok. 

 

COMBINATION CHARTS 

A combination chart uses two or more chart types to emphasize that the chart contains 

different kinds of information.  

You may have a column chart type and a Line chart type combined which will result into a 

Line – Chart. The Column chart type will have the Data series and the line will have the 

actual values.  

To create this kind of overlay effect, select a custom chart type in Step 1 of the Chart Wizard 

when you create a chart.  

This example uses the Line – Column chart type. You can change an existing chart to a 

combination chart by selecting the data series you want to change and then changing the chart 

type for that series. 

 

 

HOW RAINFAL INCREASES THE RATE OF MALARIA  
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Secondary axis    When the range of values for different data series varies widely, or when 

you have mixed types of data, you can plot one or more data series on a secondary value (y) 

axis. The scale of the secondary axis reflects the values for the associated series.  

The chart in the example shows the number of homes sold on the left y-axis and the average  

price on the right y-axis.  

 

 
 

Note:  

Columns are plotted on the Primary Axis and Lines are plotted on the Secondary Axis. 
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PAGE SETUP 

 

Page Setup controls the appearance and final layout of the printed worksheet. The settings 

apply to individual sheets within a work book.  

 

Procedure 

 

1. Click File 

2. Click Page Setup 

3. The Page Setup dialog box will be displayed where you can make settings. 

 

 

 
 

 

THE PAGE TAB 

 

Controls Page Orientation, Scaling, Paper Size, Print Quality and starting number for the 

selected sheet. 

 

Orientation 

 

Specifies the Orientation for the printed page e.g. Portrait (Tall) or Landscape (wide).  

Portrait prints with the short edge of the paper horizontally and Landscape prints with the 

long edge of the paper horizontally. 

   

Scaling 

 

Scaling enlarges or reduces the printed worksheet. 
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Scaling options 

 

(i)  Adjust To:  

 

Reduces or enlarges the printed sheet. The adjustment ranges between 10% and 400% of 

normal size. 

 

(ii) Fit To:  

 

Enlarges or reduces the worksheet or selection when you print so that it fits on the 

specified number of pages, wide or tall. The sheet or selection is scaled proportionally, 

preserving its relative dimensions, so it may print on less than the specified number of 

pages. 

 

Enter a number in the page(s) wide by box, and enter a number in the tall box. To fill the 

paper width and use as many pages as necessary, type 1 in the pages(s) wide by box and 

leave the tall box blank. 

 

Page Size 

 

Select the paper size you want from the list.  E.g. Letter, Legal, Executive, A4 or other 

size options to indicate the size you want your document or envelope printed. 

 

Print Quality 

 

Select the resolution of printing. Resolution is the quality of output expressed in Dots Per 

Inch (DPI) that will appear on the printed paper. The number of dots the better the quality 

of output.  

 

First Page Number 

 

Enter the starting page number for the printed pages of the sheet. The default is Auto 

which starts numbering with 1. 

 

THE MARGINS TAB 

 

The margins Tab controls the page margins, Header/Footer Margins and can center the 

sheet on the page vertically, horizontally or both. 

 

Margin Options 

 

(i) Top  

  

Distance between the data and top edge of the page. 

 

(ii) Bottom 

 

Distance between the data and bottom edge of the page. 
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(iii)   Left 

 

Distance between the data and Left edge of the page 

  

(iv)   Right 

 

Distance between the data and Right edge of the page 

Enter margin settings and see results in the Preview box. Adjust measurements in the 

Top, Bottom, Left, and Right boxes to specify the distance between your data and the 

edge of the printed page.  

(v) Header 
 

Distance between the Header and Top edge of the page 

 

(vi)  Footer 

 

Distance between the Footer and bottom edge of the page 

 

Note: 

 

Distance between the header and top of the page and between the footer and bottom of the 

page should less than the margin setting to prevent the header/footer from overlapping the 

data. 

 

Center on Page 

 

Centers the data on page within the margin vertically, horizontally or both. 
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HEADER/FOOTER TAB 

 

Controls the headers and footers for the selected sheet. Headers and footers are 

descriptive text that prints at the top and bottom of every page in your worksheet. 

 

You can choose from a list inbuilt headers and footers or enter your own headers and 

footers by clicking custom header or Custom footer. 

 

If you do not want a header/footer, click none form the header or footer list boxes. The 

preview areas above the header and below the footer sections show what the 

header/footer will look like when printed. 

 

 

 
 

The Dialog Box shows the Header/Footer options 

 

 

 

 

THE SHEET TAB 

 

Specifies which areas of the sheet you want to print. It also controls the print titles, Page 

order, draft quality and whether gridlines, cell notes and row/column headings should be 

printed. 
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Print Area 

 

Specifies the worksheet range you want to print. To specify print area, click the Print 

area box to select a worksheet range to print, and then drag through the worksheet areas 

that you want to print. 

 

The Collapse Dialog button at the right end of this box temporarily moves the dialog box 

so that you enter the range by selecting cells in the worksheet. When you finish, you can 

click the button again to display the entire dialog box. 

 

Print Titles 

 

Specifies whether you want to print the same columns or rows as titles on every page of a 

printed worksheet.  

 

- Select Rows to repeat at top if you want specific rows as your horizontal title for  

 each page. 

 

- Select Columns to repeat at left if you want vertical titles on each page. 

 

- Then on the worksheet, select a cell or cells in the title columns or rows you want. 

 

Note: 

The Collapse Dialog button at the right end of this box temporarily moves the dialog box 

so that you enter the range by selecting cells in the worksheet. When you finish, you can 

click the button again to display the entire dialog box. 
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Print 

Specifies what is printed from your worksheet, whether the printout is in color or black 

and white, and what the print quality is. It also specifies whether to print, Row and 

Column headings, Gridlines, comments, cell errors etc. 

 

Print Order 

Controls the order in which data is numbered and printed when it does not fit on one 

page. E.g. Down, then over or Over, then down. The sample picture previews the 

direction your document will print when you choose one of these options 

 

 

Down, then over  
Prints and numbers pages down wards and then across the worksheet.  

 

Over, then down.  

Prints and numbers pages across and then down the worksheet.  

 

 

PREVIEWING A DOCUMENT BEFORE PRINTING 

 

Next  

Displays the next page to be printed. If you have multiple worksheets selected and click 

Next when the last page of a selected worksheet appears, Excel displays the first page of 

the next selected worksheet. 

 

Previous 

Displays the previous page to be printed. If you have multiple worksheets selected and 

click Previous when the first page of a selected worksheet appears, Excel displays the last 

page of the previous selected worksheet. 

 

Zoom 

Switches between a full-page view of a sheet and a magnified view. The Zoom feature 

does not affect printing size. You can also switch between a full-page view and a 

magnified view of a worksheet by clicking any area of the worksheet.  

 

Depending on the resolution of your monitor, you may not see certain graphics, such as 

thin borders, in full-page view. 

 

Print 

Lets you set printing options and then prints the selected worksheet.  

 

Setup 

Lets you set options that control the appearance of printed sheets.  

 

Margins 

Displays or hides margin handles that you can drag to adjust page margins, header and 

footer margins, and column widths. 
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PRINTING  

 

Print your data to a printer to obtain a hard copy of your worksheet. Before printing, select 

the printer you want to use, setup the page, determine page breaks and choose what elements 

to print. For any option that do not select, Microsoft Excel uses default settings.  

 

Procedure 

 

1. Click File Menu 

2. Click Print, The Print Dialog box will be displayed as can be seen below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Select options as required. 

4. click ok to print your work 

 

Options in the Printer dialog box 

 

Printer 

 

Select a printer. The information about the selected printer is displayed.  

 

Print Range 

 

Indicates the pages of the worksheet you want to print. If you click Pages, you must also 

enter the page numbers you want.  

 

Copies 

 

Specifies the number of copies you want to print. 
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Collate 

Organizes numbered pages when you print multiple copies of a Worksheet. A complete copy 

of the document is printed before the first page of the next copy is printed.  

 

Print What 

 

Indicates the portion of the document you want to print. For example, choose selection, 

Active sheets or entire workbook 

 

- Selection 

 

Prints only the selected cells and objects on the worksheet.  

 

- Active sheets 

 

Prints each of the selected sheets. Each sheet in the workbook starts on a new page. If a sheet 

has a print area, only the print area is printed. If a chart object is selected, this option changes 

to selected chart.  

 

- Entire Worksheet 

 

Prints all sheets in the active workbook that contain any data. If a sheet has a print area, only 

the print area is printed.  

 

-Preview 

 

Shows how your document will look with the selected options.  

 

Find Printer 

 

Allows you to select a printer on your network that is not listed here. When you have selected 

the printer you want to use, click OK to return to this menu and print the document.  

 

Properties 

 

Click Properties to change the options for the selected printer. In most cases, the settings you 

specify apply only to the active worksheet. 

 

OK 

 

Click ok to print your worksheet after making necessary setting in the print dialog box. 

Otherwise click Cancel. 
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Additional notes 
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TERMS TO KNOW 
 Row - named with numbers; move left to right (Horizontal lines) 

 Column - named with letters; move top to bottom (Vertical lines) 

 Cell - the intersection of a row & a column 

 Selection Box – designated by letters for columns & numbers for rows 

 Global Selection Box – the box in the top left corner.  It selects the entire 

sheet. 

 Formula Bar 

 Adjust Cursor 
 Sheet Tabs 

 

 
 

 
 

 

 
HOME tab 

1. Font - formatting tools 

a. Border lines around cells   

 

2. Alignment tools 

a. Align data from top to bottom & left to right 

b. Rotate text orientation in cells 

c. Wrap text within cells 

d. Merge & center – merge cells & center data 

 

3. Number – format for $, %, decimals… 

 

4. Styles – pre-designed color schemes 

 

5. Cells – insert, delete, or format:  

a. Cells 

b. Rows 

c. Columns 

d. Worksheets 

 

6. Editing 

 

INSERT Tab 
1. Tables  

2. Illustrations 

Select functions 

Fill formulas 

Sort or filter data: 

A to Z   or    Z 

to A 

Custom Sort 

Filter 

 

Sheet Tabs can 
be: 
 Renamed 
 Reordered 
 Colored 
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3. Charts – see below for more detail 

4. Sparklines - a tiny chart in a worksheet cell that provides a visual representation 

of data. Use sparklines to show trends. 

5. Filter – slicers used to filter pivot table data 

6. Links – Internet, bookmarks, other documents 

7. Text 

a. Text Box 

b. Header & Footer 

c. WordArt 

d. Signature Line 

e. Object – use to embed a sound file, video, etc. 

f. Symbol 

 

 

 
 

 
 

 
CHARTS 

 
 
TIP: Select multiple columns or rows (contiguous or not) by holding down the CTRL key 

while clicking the selection box for the column or row. 

 

Chart DESIGN ribbon – change the layout & chart style appearance 

 

 

 

 

Chart LAYOUT ribbon 
 

 

 

Chart FORMAT ribbon 
 

 

 

 

 

Change colors of lines, fills, or backgrounds: 

- Double click the item you wish to change and use the Format Data Point dialog box 

to make the desired changes. 

 

Chart LAYOUT ribbon  

 

 

 
     Date & Time 

Help! 
Which chart is 
best for my data? 

Use the following charts: 
  Bar/Column to compare quantities 
  Line/Area to show trends or growth 
  Pie to show the parts of a whole 
  Scatter to compare pairs of values 

 

How do you close the Header/Footer view? 
 

View tab  Normal View 

Change the chart from being an object on 
the worksheet to a separate worksheet 

Change to a different type (pie, bar, etc.) 
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PAGE LAYOUT tab 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 
 

 
 

 
 

 
 

 
FORMULA tab 

1. Create a FORMULA   (write a formula for the computer to apply) 

A. Type an equals (=) sign in the desired cell. 

B. Enter the formula either by typing it or clicking the desired cells & inserting the 

math operations.  Examples:  =C4+A2    =C4-A2    =C4*A2    =C4/A2    

=(A2+C4)*4 

C. Press Enter.  The value displays in the cell. The formula displays in the Formula 

Bar. 
 

2. Use a FUNCTION   (select from a wide variety of pre-built formulas) 

A. Type a plus (+) Or equal sign (=) sign in the desired cell to begin. 

B. Click the Function Box drop down arrow & select the desired function   

C. When the Formula Palette appears, check to be sure the computer is 

selecting the desired cells and posting an appropriate answer.  Make 

formula corrections here, if necessary. 

D. Click OK 

DATA tab 

 

When printing a multi-page document repeat the column 
headings row at the top of each page or the first column 
on the left side of each page: 
 

Print Titles  opens the Page Setup box  Sheet tab 

Click the worksheet icon with the 
red arrow  click the selection 

box for the row or column you 
wish to have printed on each page 
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Powerful lessons can utilize real-time data from the Internet. Data can be copied & 

pasted into Excel.  Oftentimes, when multiple columns of data are imported from 

Internet sites they import into only the 1st column.  If so, it must be divided into multiple 

columns before it can be fully utilized. 

1. Highlight the column in which the data resides using the selection box at the top 

2. Data tab  Text to Columns  choose either Delimited (data is separated by a 

comma, semicolon, etc.) or Fixed Width  next  etc. 

 

 
Internet sites containing data to use in lessons: 

Landmark for Schools - list of sites with raw data & suggestions for use - http://landmark-

project.com/page.php?stamp=&pn=4&psn=&cat=22       

Census - http://factfinder.census.gov/home/saff/main.html?_lang=en  

Earthquakes - http://www.ncedc.org/cnss/catalog-search.html 

Information Please Almanac - http://www.infoplease.com/almanacs.html 

New York Stock Exchange - http://www.nyse.com/ 

US Department of Labor statistics - http://www.bls.gov/data/  

 

 
 

REVIEW tab 

 

 

 

 

  

The Sort & Filter functions are also available 
on the right side of the HOME tab. 
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VIEW tab 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

  

 

4 pages per big book 

page 

6 pages per poster 

Use Freeze Panes to freeze the top row or 1st column 

in a large spreadsheet while scrolling down or 

sideways.  You can freeze both at the same time. 
Use Page Break Preview to 

put page break lines on the 

worksheet when designing: 
 

 Big Books - multiple pieces 

of paper to create one 

page 

 Posters - enlarge a graphic 

larger than one piece of 

paper 
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LOOKUP TABLES  
Lookup tables contain data that can be drawn upon or used to insert information in 

another table.  In the field of education a lookup table could hold a grading scale that 

can supply letter grades for a given set of scores. 

 

1. Create the LOOKUP table, preferably on an unused 

worksheet.  To keep organized, name the worksheet 

LOOKUP 

a. In the 1st column, enter the lowest values (points) in 

ascending order (lowest to highest) for each specific 

grade.   

b. In the 2nd column, enter the letter grade assigned to 

the point value from the 1st column. 

c. Select the cells containing the grades & values.  In this case, highlight 

from A1 through B5. 

d. Type a name for this table (grades) in the Name Box of the Formula bar 

& press Enter… displayed in the red circle on the above diagram. 

2. On the grade book worksheet, click in the cell where the letter grade is to be 

calculated and posted. 

3. Click the Function button (fx) on the Formula bar  

4. Select the Lookup & Reference category 

5. Select the VLOOKUP function & click OK 

 

6. Complete the Function Arguments box: 

a. Lookup_value is the worksheet cell that 

contains the student’s total points 

b. Table_array is the name of the LOOKUP 

table created in step 1 above.  Be exact! 

c. Col_index_num is the number of the 

column containing the letter grade.  Type 

the number 2 since column B of the 

LOOKUP table contains the letter grades & 

it is the 2nd column in the LOOKUP table. 

d. Range_lookup is true or leave it blank.  

“True” means Excel will look for a grade 

range instead of an exact number.   

e. Click OK 

 

 

 

 

 

 

 

 

 

 

 

 

7. Use the Fill down technique to calculate grades for the remaining students in the 

grade book. 

RANK 
The Rank function can display the order of scores without using the Sort command.  

Data can be ranked from high to low or low to high. 

 

The rank function can be found in the Statistical or All categories and looks like this: 
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RANK(number,ref,order) 

Number   is the number whose rank you want to find. 

Ref   is an array of, or a reference to, a list of numbers. Nonnumeric 

values in ref are ignored. 

Order   is a number specifying how to rank number. 

 If order is 0 (zero) or omitted, Microsoft Excel ranks number as if 

ref were a list sorted in descending order.  

 If order is any nonzero value, Microsoft Excel ranks number as if 

ref were a list sorted in ascending order.  

 

 

To fill down the function and return data from highest score (1st) to lowest score: 

 

 

 

 

 

 

 

 The function in cell O2 would be =RANK(N2,N2:N8) 

 If you want to fill down the function you must add $ signs like this: 

  =RANK(N2,$N$2:$N$8) 

  

 

 

To fill down the function and return data with the lowest score to highest score as in 

golf: 

 

  

 

 

 

 

 

 

   The function in cell O2 would be =RANK(N2,N2:N8,1) 

 Adding the ,1 after the range causes it to sort with the lowest score as 1st 

place 

If you want to fill down the function you must add $ signs like this: 

  =RANK(N2,$N$2:$N$8,1) 
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Need help with something specific?   
1. F1 – Help menu 

 

2. Microsoft Online Excel Help - http://office.microsoft.com/en-

us/excel/FX100646951033.aspx  

 

3. Microsoft Excel 2010 Help - http://office.microsoft.com/en-us/excel-help/  

 

4. Atomic Learning: 

a. http://pod.nku.edu – click on the graphic for Atomic Learning, not the 

text.  If on campus, Atomic Learning opens automatically.  When accessed 

off campus, you’ll be prompted to enter your NKU email username and 

password.   

 

 

 
 
 
 
 
SPREADSHEET USES for EDUCATORS: 
 

Management & Instructional Aids: 

 Grade book 

 Class information database - use for mail merge into letters, envelops, labels, 

certificates… 

 Lesson Plan Book 

 Weekly lesson plan calendar 

 Seating chart – include student photos (taken with a digital camera) 

 Create “big books” or large posters of graphics or photographs   

 To see the page breaks:  View tab  Workbook Views group  Page 

Break Preview 

 Create graph paper in various sizes (templates can be found on Microsoft Online) 

 

Instruction: 

 Math – algebra formulas, rounding of numbers, organizing data, problem solving 

 Social Studies – organize, sort, and display data 

 Science – organize, calculate, and chart data 

 Language Arts – organize (alphabetize) vocabulary lists, book collections, reading 

logs, create “big books” 

 

Dr. Christie’s Using Spreadsheets in K-12 Classrooms 

 

http://office.microsoft.com/en-us/excel/FX100646951033.aspx
http://office.microsoft.com/en-us/excel/FX100646951033.aspx
http://office.microsoft.com/en-us/excel-help/
http://pod.nku.edu/
http://alicechristie.org/edtech/ss/index.html
http://proxy1.nku.edu/login?url=http://movies.atomiclearning.com/highed/tutorials

